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Setting Up Your Data Collection System 
 
 
There are some important points to consider when setting up your system initially: 
 
 
Location - There needs to be enough space for the scanner to be located near to the 
computer being used to operate it.  This is so that any on-screen messages can be viewed 
while operating the scanner. 
 
 

 
 
 
Email facilities - It is preferable if you are using a machine that has email facilities to enable 
you to obtain software updates and allow files to be exchanged easily, if required, during a 
support call. 
 
Telephone - It is advisable when making a support call to have the software running on a 
computer that you have access to so that queries can be dealt with step-by-step. 
 
 
 
 
Support 
 
If you have a question about SpeedQuest you can contact Speedwell using one of the 
methods below. 
 
By Phone 01933 445820  
 
By Fax  01933 445829 
 
By E-Mail support@speedwell.co.uk 
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Installing Your Software 
 
Simply put the CD into your disk drive and the installation will autorun.  If this feature is 
disabled on your computer navigate to the CD drive from Windows Explore and click Setup. 
 
Installation Number 
 
During installation of the SpeedQuest software on a computer you are asked to give a unique 
Installation No.  This number is then overprinted onto all questionnaires printed from this 
machine.  The purpose of this is to identify where questionnaires originated, it is part of the 
verification features of the software.  This is particularly useful if you have a number of 
machines using SpeedQuest within an office, (maybe one computer per department running 
SpeedQuest, for example).  In this situation, if questionnaires become mixed up, scanning will 
halt and alert you - which will save you scanning incorrect questionnaires into a data file 
which, in turn, will save you time. 
 
Registering SpeedQuest 
 
To register your copy of SpeedQuest, key in the name of your organisation and department, 
exactly as they appear on the registration card, and then enter your registration code. 
Your organisation name will be the first line on the card, the department name the second 
line. This will then be printed on all reports. 
If you do not register your copy of SpeedQuest for Windows, you will only have a 
demonstration version, and certain functions will be disabled. 
 
If you have a demonstration copy and wish to purchase the full version, please contact 
Speedwell for a registration code. 
 
 
 
Using SpeedQuest  
 
Questionnaire Generation 
 
To avoid any possibility of generating questionnaires that cannot be scanned, 'SpeedQuest' 
makes use of pre-printed machine readable documents with blank spaces where the 
questions and their associated response anchors are to be printed. All you have to do is type 
in the questions you wish to ask. 
 
There are a number of standard questionnaire formats (templates) designed to reflect the 
style of questions being asked, although you are free to design your own templates to suit 
your own precise requirements. 
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SpeedQuest Interface 
 
The main questionnaire viewing and editing interface of the program, consists of a preview 
pane on the right of the screen, where an image of the current questionnaire is displayed, and 
a questionnaire editing window on the left of the screen, where the questionnaire's data 
can be inserted or edited. 
*  It is possible to resize these windows if required  
 
By left clicking to select a row of data in the questionnaire editing window you will be able 
to see a highlighted area within the preview pane, this highlighted area will indicate where on 
the pre-printed form the data will eventually be printed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Status Bar 
 
The status bar shows the filename (or Draft if the questionnaire has not been saved), a 
reference to the user specified questionnaire no. , and the number of scanned data records 
currently stored for this questionnaire. If any report filters are on, this will be indicated here.  
Each of the columns in this screen are described on the next page. 
 
 
 
Tool Bar 
 
 
 
 
 
 
 
 
 
 
 
At the top of the questionnaire editing window there are a number of headings, see next 
page for a more detailed description.
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Reference 
  
 
No. 
This column contains the unique identifier for data entries; it corresponds to the area on the 
form where the text will appear. (see data grid ) 
 
Text 
In this column textual data, such as questions or headings can be entered on the row that 
corresponds with where you want the data to appear. 
 
Ovp 
This column shows whether overprinting has been enabled. 
YES - indicates overprinting enabled     No - indicates overprinting disabled 
 
Lookup 
Using lookups is an advanced feature of the software which can be used to pre-identify a 
questionnaire. 
 
Responses  
This column shows the available responses for a question, represented by the response 
identifiers  
 
Link  
Each row on the table is given a link no., which identifies the text areas that have the same 
properties. For example, all the titles could be labelled with link no.2 and question/response 
text areas could be labelled with link no.3. Any text area can be moved to a row containing 
the same link no. 
 
Rep 
The Rep column confirms whether the responses from a data record are to be included within 
a report or not.     
 
 YES - include in reports   NO - exclude from reports   N/A - not applicable 
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Creating a New Questionnaire 
 
 

Text Editing Options 

1. In the Configure menu, click Defaults. The Application Defaults window will now open, 
click on the Edit tab, here your editing options can be changed and/or confirmed.  
 
          
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.   The Font displayed will be the default font used in all text editing 
 
3.   Click Save to update your scanning options. 
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Opening a Blank Questionnaire Template 

 

1. On the toolbar left click , or alternatively in the File menu, point to New, and then click From 

RSD. (Response Sheet Definition File) 

2. In the Select RSD window, locate and click on the file you require, and then click Open. 

3. This will open a completely blank template of a questionnaire. 

 

Printing a Data Grid 

 

By printing a data grid on a pre-printed form you will be able to see exactly where on a 

questionnaire each text and response field will appear, with the corresponding number (No.) from 

the questionnaire editing window.  The data grid is like a layout plan of the form and cannot be 

edited itself. 

1. On the toolbar left click , or alternatively in the File menu, click Print Grid*. 

2. In the Overprint Setup window, left click OK 

 

*The side of the questionnaire you want to print a grid for must be visible in the preview pane - i.e. 

to print a grid of the rear of the questionnaire you will need to highlight a row of data that appears 

on that side, then check that the rear of the questionnaire is visible in the preview pane before 

printing a data grid. 

 

Inserting a Title for Questionnaire  

 

1. In the questionnaire editing window, left click the row where you want your title to appear, check 

in the preview pane to confirm its position.  

2. Once you have verified the position double click that row. (Or right click the row and from the 

pop-up menu click edit) 

3. In the Edit Text window, type your title and format text if required. 

4. Left click   to save, then   to exit the editor. 
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Inserting Text into a Questionnaire  

 

1. In the questionnaire editing window, left click the row where you want your text to appear, 

check in the preview pane to confirm its position.  

2. Once you have verified the position double click that row. (Or right click the row and from 

the pop-up menu click edit) 

3. In the Edit Text window, type your text and format if required. 

4. Left click   to save, then   to exit the editor. 

 

Inserting Questions  

 

1. In the questionnaire editing window, left click the row where you want your question to 

appear, check in the preview pane to confirm its position. 

2. Once you have verified the position double click that row. (Or right click the row and from 

the pop-up menu click edit) 

3. In the Edit Text window, type your question and format text if required. 

4. Left click   to save, then   to exit the editor. 

 

Inserting Responses to Questions             

                                                                                                

1. In the questionnaire editing window, left click the row where you want your responses to 

appear, check in the preview pane to confirm its position.  

2. Once you have verified the position right click that row and from the pop-up menu click 

Responses. 

3. In the Edit Responses window, (next page), enter your responses.  

4. When you have inserted your responses click Save to exit this window and update your 

questionnaire.   

 

 



10 

Edit Responses Window  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Char 

In the Char column an identifier for the available responses is entered, this may be 1,2,3,   or 

a,b,c etc. Whatever is entered into this column will appear in the Responses column of the 

questionnaire editing window  

 

Response Text 

In the Response Text column you can type in textual responses to the questions, this may be 

Strongly Agree, Agree, Neutral, Disagree, Strongly Disagree – for example 

Code 

The Code column gives an identifiable code for each response, this could be the initial letters 

of the response for example. 

i.e.   Textual Response - Yes                         Code - Y 

        Textual Response - No                          Code - N 

        Textual Response - Don't Know            Code - DK  
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Identifier to Overprint 

Here you are able to choose whether to overprint the code, the text or nothing onto the 

questionnaire.  If you already have a column on your questionnaire where the responses are 

shown you would click the 'none' radio button to indicate that you want nothing printed in this 

area.  

 

Fonts/Justification 

Here you are able to change the font and justification of the response text.  

 

Block Out Unused Responses 

If you have more available areas on your questionnaire for responses than you have actual 

responses, you can click this box to have the remaining areas greyed out on your printed 

questionnaire to avoid people being tempted to use them. 

For example - if you have 5 response boxes available, but only use the responses Yes or No, 

the Block Out Unused Responses box can be checked so three of the boxes on the printed 

questionnaire will be greyed out. *note: this function may not work with all scanners, please 

check. 

 

Allowed Response Selection 

If the person filling in the questionnaire is only required to enter  one response to this 

question, the One of Many radio button should be checked.  If the person can have multiple 

responses to a question, the Many of Many radio button should be checked.  

 

Critical Data 

If it is essential that the response from a question is filled in on the questionnaire, this box 

should be checked.  During scanning, any questionnaires that do not contain this critical data 

will be detected and you will be alerted. 

If the Critical Data is box checked then any questionnaires that do not have a response for 

this question will be rejected when scanned unless this option has been turned off in the 

Scanning Options. 

See understanding critical data for further information  
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Saving a Questionnaire        

1. On the toolbar left click , or alternatively in the File menu, click Save. 

2. In the User Specified Questionnaire No. window, type in a number (maximum of two digits 

in length) which will identify this questionnaire from others, click OK.  

3. In the Select RSQ window, type in an appropriate filename for the questionnaire, left click 

Save. 

4. You have now saved this questionnaire to the Questionnaire Library   

           

Selecting Items to Overprint onto Pre-Printed Questionnaire   

1. In the questionnaire editing window, each row that will overprint onto your questionnaire will 

have YES in the OVP column. 

2. To turn overprinting on or off, right click on a piece of text, in the pop-up menu left click on 

overprintable - a tick next to overprintable in this pop up menu indicates that it will overprint 

this piece of text.                        

  

Printing a Draft Questionnaire 

1. On the toolbar left click , or alternatively in the File menu, click Print Draft*. 

2. In the Overprint Setup window, left click OK 

 

*The side of the questionnaire you want to print must be visible in the preview pane - i.e. to 

print the rear of the questionnaire you will need to highlight a row of data that appears on that 

side, then  

 

To print a finished questionnaire see Overprinting     
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Modifying an Existing Questionnaire  
 
Opening an Existing Questionnaire 

1. On the toolbar left click , or alternatively in the File menu, point to New, and then click 

From RSQ.   (Response Sheet QuestionnaireFile) 

2. In the Select RSQ window, locate and click on the file you require, and then click Open. 

3. This will open an up an editable version of a pre-designed questionnaire, from the 

questionnaire library. 

 

Editing an Existing Questionnaire 

 

Once you have opened an existing questionnaire, you are able to edit text, titles, questions 

and responses, save and print, in the same way as you would with a new questionnaire—(see 

previous pages) 

 

Moving Text or Questions to a Different Place on the Questionnaire 

 

1. In the questionnaire editing window, left click the row where the text appears; check in 

the preview pane to confirm its position. 

2. Right click on this row, in the pop-up menu click move. 

3. In the move text window type in the number of the row you want to move the text to then 

click OK. *Please note that you can only move text to a row with the same link no. 

4. The text or question will now be in its new position. 
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Questionnaire Libraries 
 
 
Having generated a questionnaire, it is given a title and stored in the questionnaire library 

ready for printing.  New questionnaires may be added, existing questionnaires may be 

deleted and existing questionnaires may be modified. 

 

Opening a Questionnaire from the Library 

1. On the toolbar left click , or alternatively in the File menu, click Open 

2. In the Select RSQ window, locate and click on the questionnaire you require, and then 

click Open. 

3. This will open an up an non-editable version of a questionnaire, from the questionnaire 

library, ready for scanning or reporting.  

 

 

 

 

Saving a Questionnaire 

1. On the toolbar left click , or alternatively in the File menu, click Save. 

2. In the User Specified Questionnaire No. window, type in a number (maximum of two digits 

in length) which will identify this questionnaire from others, click OK.  

3. In the Select RSQ window, type in an appropriate filename for the questionnaire, left click 

Save. 

4. You have now saved this questionnaire to the Questionnaire Library 
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Printing Questionnaires 
 
Producing questionnaires couldn't be more simple.  The required questionnaire is selected 

from the library, the appropriate stationery loaded into a laser printer, the number of 

questionnaires required entered into the system.  The software then overprints the questions 

along with any category information producing the finished questionnaires - ready for 

circulation. 

 

Printer Alignment 

Pre-printed response sheets always have an ID line. This line is found at the top of a sheet, 

see below.  During overprinting marks are made on this ID line which identifies the sheet 

when scanned. It is essential that the printer is aligned correctly or the marks will be misread 

by the scanner and the sheet rejected. See How OMR Scanning Works (page 21) to 

understand this further. 

 

Below are the tops of the two different response sheets which are aligned differently.   

 

Sheet Type 1 

 
 
 
 
Sheet Type 2 

 

 



16 

Sheet Type 1 Alignment 

 

1.   From the Configure Menu, select Align Overprint 

2.   In the Align Overprinting Window (shown below) click the Print Test button to overprint 

alignment marks onto your response sheet. 

3.   The diagram below shows where the alignment marks should be printed.  

 

 

 

 

 

 

 

 

4.   If these marks do not appear like this on your sheet adjustments need to be made in the 

Align Overprinting Window.  Make adjustments as necessary and continue to print test 

sheets until these marks are aligned. 
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Sheet Type 2 Alignment 

 

1.   From the Configure Menu, select Align Overprint 

2.   In the Align Overprinting Window (shown below) click the Print Test button to overprint 

alignment marks onto your response sheet. 

3.   The diagram below shows where the alignment marks should be printed. 

 

 

 

 

 

 

 

 

4.   If these marks do not appear like this on your sheet adjustments need to be made in the 

Align Overprinting Window.  Make adjustments as necessary and continue to print test 

sheets until these marks are aligned. 
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Printing a Finished Questionnaire (Overprinting) 

1. Check that your overprinting configuration is set up correctly in Overprinting Options and that your 

printer is aligned correctly in Printer Alignment. 

2. On the toolbar left click , or alternatively in the Process menu, click Overprint Front or 

Overprint Rear*. 

3. If this is the first time you have overprinted this questionnaire this warning message will be shown.  

 

 

 

 

 

4. Click YES to continue. 

5. In the Overprint Sheets window (as below), enter the number of questionnaires you want to overprint 

and left click Continue.  

 

 

 

6.   In the Overprint Setup window, click OK to overprint the questionnaires.  
 

    

*The side of the questionnaire you want to overprint must be visible in the preview pane - i.e. to overprint the rear of 

the questionnaire you will need to highlight a row of data that appears on that side, then check that the rear of the 

questionnaire is visible in the preview pane before overprinting.  
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Scanning 
 
 
After completion the documents are scanned into a data file that is stored under the 

appropriate questionnaire title in the questionnaire library.  Any number of scanned files may 

be stored under a questionnaire title. 

 

How OMR Scanning Works 

 

Response sheets are scanned through an OMR scanner. Each sheet contains small circles, 

referred to as 'bubbles,' that are filled in by the respondent. OMR cannot recognize hand-

printed or machine-printed characters; an image of the sheet is not created by the scanner, it 

simply detects the absence or presence of a mark, but not the shape of the mark.  

 

An OMR scanner has a number of read heads (40 or 48, see scanner configuration) which, as 

it is fed through, splits the sheet into that number of columns (or tracks).  Clock tracks (or 

timing marks) along one edge of the sheet indicate to the scanner where to read for marks. 

Only when the scanner detects a clock track (or timing mark) does it read across that row 

looking for marks which are either for identification or are marked responses. 

 

The way OMR works makes it essential that sheets that are overprinted are aligned correctly. 

 If there are marks in the wrong places (or misaligned) the scanner will reject the sheet.  This 

can have devastating effects if large numbers of sheets have been overprinted incorrectly and 

the data collected on them is unscannable. 
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Scanner Configuration 
 
The software will normally be configured correctly for your particular Optical Mark Reader, but 

should you change the model of scanner, you will need to use this option. 

 

Select Scanner from the Configure menu. 

The scanner type can be selected from the drop down box, 

Scanners currently supported are - 

  Axiome AXM900 Series 

  DRS CD and OMR Series 

  Kendata XR5 

  NCS OpScan Series 

  Scantron Scanmark 2000 Series  

 

The number of tracks on the scanner, either 40 tracks (5 tracks per inch, 0.2" pitch) or 48 tracks 

(6 tracks per inch, 0.166" pitch). 

 

The minimum darkness value determines the lightest mark that will be recognised by the 

scanner. This value can be from 0 (the lightest mark) to 15 (the darkest mark). If the scanner is 

recognising light marks that you would like to be ignored, increase this value. If the scanner is not 

recognising dark marks that you think it should, decrease this value. 

 

The minimum difference value is the minimum difference between the darkness values of two 

marks that causes the lighter mark to be ignored. If the difference between the two marks is less 

than this minimum difference value, a multiple mark error is returned. This value can be between 0 

(lighter marks always ignored) and 15 (lighter marks never ignored). 

 

The minimum darkness additive value is a minimum darkness for additive fields, it performs the 

same function as the minimum darkness value above. This only applies to additive fields, where 

multiple marks are allowed, and their values are added together. 

 

Check the 'Use Printer' option if you are using the printer on the scanner. 

Not all options may be available, depending on the scanner type.  
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Scanning Options 
 
1. In the Configure menu, click Defaults. The Application Defaults window will now open, 

click on the Halt Scan tab, here your scanning options can be changed and/or confirmed.  

 

 

 

          

 
 
 
 
 
 
 
 
 
2.   Click Save to update your scanning options. 
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Scanning Questionnaires 
 
 
1. Prepare the scanner and insert a batch of questionnaires ready to scan. Feed the sheets 

through the scanner, with the clock track (the row of black timing marks) towards the front or 

bottom of the machine.  

2. Open the required questionnaire, see Opening a Questionnaire from the Library 

3. Once the correct questionnaire has been selected to scan, check your scanning options. 

4. Click , or alternatively from the Process menu click Scan. 

5. In the Scan Batch window (below), you can see the automatically generated batch number 

in the window header. 

6.By default, the batch title of the last scanned batch will be displayed.  Click Continue to 

accept this title, or edit the title if required. 

 

 

 

 

7.In the Scanning window, below, you can see the number of forms scanned successfully, 

the number of forms rejected and the status of the scanning procedure. 
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Scanning Problems 
During scanning one of the following sheet errors may be reported: 

 
Incorrect sheet fed 

Document No. expected 

Skew error 

Black test error 

White test error 

Invalid front overprint alignment 

Invalid rear overprint alignment 

Invalid front checksum 

Invalid rear checksum 

Incorrect front questionnaire number 

Incorrect rear questionnaire number 

Incorrect front installation number 

Incorrect rear installation number 

Duplicate sheet number 

Unexpected sheet number 

Unexpected pre-printed document code  

 

 

If you find that you are scanning sheets and they are not being recognised (i.e. the sheets are not 

being either rejected or accepted) then you are feeding the sheet into the scanner incorrectly.  Re-

feed the sheets correctly to resolve the problem. 

 

For more information on these errors press F1 whilst in SpeedQuest and search for the error you 

are receiving. 
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Viewing/Editing Questionnaire Data Files 

 

Viewing Scanned Data 
 
1. Load the scanned data required by opening a questionnaire from the Library. 

2. On the toolbar left click , or alternatively in the File menu, click View Data.   

 * It is possible to click  at any time to switch between the questionnaire editing interface view 
and the data view. 
 
3. In the data view, each scanned questionnaire will appear in the table referenced by a sheet 

number, a batch number, a batch title and, optionally, a lookup.        

 

 

 

4.Each row in the table represents an individual data record for each questionnaire scanned 

 

Viewing Individual Data Records 

1. Double click on any questionnaire in the table. 

2. In the Edit Sheet window (below), which pops up, you can view or edit any of the data in the 

record. 

 

 
3.   Any responses that are blank or contain multimarks will be highlighted in this window.  To 

change the colour of these highlights click defaults in the Configure menu. In the Application 

Defaults window make any changes necessary. 

4.  Edit any of the responses by right clicking the response, and then left clicking an 

alternative response from the pop-up menu to select it. 

5.  Click either Save or Abandon changes to close this window.  
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Show All Data 

 

If you only have a filtered selection of scanned data on view in the Data View window,  right 

click anywhere on the table, click Filtered Shown. All scanned data will be shown now. 

 

 

 

Show Filtered Data 

 

If you have all scanned data on view in , and have applied a filter, right click anywhere on the 

table, click Filtered Shown. All scanned data will be shown now. 

1.  You can choose to view just your filtered selection of data in the Data View window. 

2.   Right click anywhere on the table, in the pop-up window left click Filtered Shown. 

3.   Only the files to be reported on will be on view now. 

 

 

 

Deleting Individual Data Records 

 

1.   Right click on any questionnaire data record in the table. 

2.   In the pop-up menu, left click Delete. 

3.   In the Confirm window, click OK.  
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Filtering Scanned data 
 
By filtering the scanned data records you are able to choose what data your reports will be based 

on.  Filtering is the way you choose data to be included/excluded in reports. 

 

Applying a Batch Filter 

 1.   In the Data View window, right click anywhere in the table.  In the pop-up menu left click 

Filter 

 

 

 

 

 

2.   In the Filter Data window make sure that the Batch Filter On box is ticked, and the Data 

Filter On box is unticked, as above. 

3.   Click on Tab 3) Batch.  In this window, below, type in the batches you want to include using 

the rules stated. 

 

 

 

 

4.   To save the filter you have just created click on Tab1) Combination. Click Add Current Filter 

Options To Library.  In the Filter Options Name window type in an appropriate name for the filter 

and click OK.      

 

5.   Click Save to exit.  You will be asked to confirm filter changes before saving - should any 

changes have been made to the filter. 
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Applying a Data Filter 

1.  In the Data View window, right click anywhere in the table.  In the pop-up menu left click 

Filter 

 2.   In the Filter Data window make sure that the Data Filter On box is ticked, and the Batch 

Filter On box is unticked. 

3.   Click on Tab 2) Data.  In this window, below, right click in the table to edit the boolean 

statement. 

 

 

 

 

 

 

4.   To save the filter you have just created click on Tab1) Combination. Click Add Current 

Filter Options To Library.  In the Filter Options Name window type in an appropriate name 

for the filter and click OK.    

5.   Click Save to exit.  You will be asked to confirm filter changes before saving should any 

changes have been made to the filter. 

 

The boolean statement is laid out in a table.  Each statement is numbered in the left hand 

column. By right clicking in the No. column and then clicking on either Insert Above, Insert 

Below or Delete, from the pop-up menu, you can add/remove statements easily.  

 

Simply right click in each of the columns to make a statement to include or exclude data 

records.  
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 Applying a Numeric Filter 

 

1.   In the Data View window, right click anywhere in the table.  In the pop-up menu left click 

Filter 

2.   In the Filter Data window make sure that the Numeric Filter On box is ticked, and the 

Data Filter On box  as well as the Batch Filter On box is unticked. 

3.   Click on Tab 5) Numeric.  In this window, below, type in the number of the first numeric to 

be used for filtering purposes  (this may be the first number of the entire numeric or wherever 

the numeric filtering will begin).  Then type in the number of  the last numeric to be used. (this 

may be the last number of the entire numeric or wherever the numeric filtering will end) 

 

 

 

 

 

 

 

 

 

4.   In the filter string box type in the numerics you want to include using the rules stated. 

5.   To save the filter you have just created click on Tab1) Combination. Click Add Current 

Filter Options To Library.  In the Filter Options Name window type in an appropriate name 

for the filter and click OK.     

6.   Click Save to exit.  You will be asked to confirm filter changes before saving - should any 

changes have been made to the filter. 
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Reporting 
 
Meaningful high quality reports incorporating frequency counts and easy to interpret graphics such 

as pie charts are produced automatically.  If you wish to perform more detailed analysis, a data 

export facility is provided.  Scanned data  for the same questionnaire may be selected from the 

library and then combined to form composite reports.  'Sub set' reports may be produced using 

pre-defined filters or by filtering on the group responses to individual questions. 

 

Create a Report from all Scanned Data  

1. In the Data View window, (see viewing data) confirm that all data is available by looking in the 

status bar. If only a filtered selection of data records are available this will be indicated here. 

Remove all filters if necessary. 

2. Now you are able to produce reports that includes all of the scanned data. 

 

Including/Excluding Questions for Reporting 

In the questionnaire editing window you can see the questions that will be included in reports by 

looking in the Rep column. 

 

1. In the questionnaire editing window, each row that will be included in reports will have YES in 

the Rep column. 

2. To include/exclude questions from reports, right click on a piece of text, in the pop-up menu left 

click on Use In Reports - a tick next to Use In Reports in this pop up menu indicates that this 

question is to be included in reports.  
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Creating a Pie Chart Report 

Before you create a pie chart report it is important to add a title and format the report. The 

appearance and settings of the pie chart can also be viewed/amended before creating the report. 

See formatting reports. 

 

1. On the toolbar left click , or alternatively in the Process menu, point to Reports, and then 

click Pie Report. 

2. In the Report Setup window, left click OK. 

3.   A preview of your pie chart report is now displayed.  

 

 

 

4.  To save the report as in a PDF, HTML or RTF format click   

5.   To close the report click  . 
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Creating a Bar Chart Report 

Before you create a bar chart report it is important to add a title and format the report. The 

appearance and settings of the bar chart can also be viewed/amended before creating the 

report. 

1. On the toolbar left click , or alternatively in the Process menu, point to Reports, and 

then click Bar Chart Report. 

2. In the Report Setup window, left click OK. 

3. A preview of your bar chart report is now displayed.  

 

4.  To save the report as in a PDF, HTML or RTF format click   

5.   To close the report click  . 
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Creating a Frequency Table Report 

Before you create a frequency table report it is important to add a title and format the report. 

The appearance and settings of the frequency table can also be viewed/amended before 

creating the report. 

1. On the toolbar left click , or alternatively in the Process menu, point to Reports, and 

then click Frequency Table Report. 

2. In the Report Setup window, left click OK. 

3. A preview of your frequency table report is now displayed.  

 

4.  To save the report as in a PDF, HTML or RTF format click   

5.   To close the report click  . 

 

 



33 

Formatting Reports 
 
1. In the Configure menu, click Defaults. The Application Defaults window will now open, 

click on the Report tab, here your report options can be changed and/or confirmed. 

 

 

2. Click Save to update your report options. 

 

Report Header 

If required type a heading for your report in here.  

 

Omit Default Header 

If this box is unchecked the default header will appear 

at the top of reports. If this box is check the default header will be omitted from reports. 

The default header is: 

Speedquest Frequency Report 

Based on no.of sheets in report - from filename  for - registered owner of Speedquest  

 

Omit Multimarks 

If more than one response has been recorded for a question on a questionnaire it is called a 

multimark. To represent questions yielding multiple responses leave this box unchecked. To 

omit multimark results check this box.  
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Omit Blanks 

If no response has been recorded for a question on a questionnaire it is called a blank. To 

represent questions yielding no responses leave this box unchecked. To omit blank results 

check this box.  

 

Omit Date of Printing 

To include the date of printing at the bottom of the report, this box should be unchecked. To 

omit the date of printing from the report check this box.  

 
Omit Page Numbering 

To include the page numbers at the bottom of the report, this box should be unchecked. To 

omit the page numbers from the report check this box.  

 

Use Means Where Appropriate 

Only check this box if you have used scores in the questionnaire, see advanced features for 

further details.  

 

Advanced Report Settings 

Click the Advanced button to view the Report Header Settings. 

 

          

 

By ticking any of these options, parts of the report header can be omitted. 
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Advanced Features 
 

Exporting Scanned Data for External Reporting 
 

1. On the toolbar left click , or alternatively in the File menu, click Export. 
2. In the Export Options window (below), choose whether to include a Header and Record 
ID info, in the export, by checking the appropriate boxes. 

 

 
  

 

3.   Now click one of the radio buttons in the Export Data box to confirm which information is 

to be exported, you can choose to export either chars, codes, texts or scores. Click Continue 

when you are happy with your options. 

4. In the Select Export File window, type in an appropriate filename for the export file, left 

click Save. 

5. You have now saved this export as a .csv file.  

 

 

Organizing/Backing Up Questionnaires 
 
RSQ files can contain large amounts of data collected from scanned responses which, if 

inadvertently lost, could have devastating effects. Therefore we would recommended that you 

organize and periodically back up your RSQ's. 

One method of organising your files to avoid accidental loss would be to create two folders 

named  

RSQ Templates - any questionnaires designed in SpeedQuest can be saved here for the 

purpose of editing. Only overprinted questionnaires need to be copied to the RSQ Data folder  

RSQ Data     - where you would save questionnaires that have been overprinted and 

have/expect scanned response data.  It would be advisable to back up this folder regularly. 
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Port Configuration  
 
The software will normally be configured correctly for your particular model of scanner.   

1. Select Port from the Configure menu. 

 

 

2. These settings should not be changed, unless by the advice of Speedwell Technical 

Support.  Unnecessary alteration may result in the software not being able to communicate 

with the scanner. 

Contact Speedwell Software Support for further advice  
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Using Lookups 
 
It is possible to pre-identify certain questionnaires (ones that have a lookup line printed on the 
form) using details from an existing database or spreadsheet. Data saved as a csv, or comma 
separated values can be imported into SpeedQuest.  You have full control of selecting how 
many and which fields are used for lookups so the questionnaire can be personalised to any 
level desired. 

 
 

 

The screenshot above shows a csv file opened within Excel, here you are able to see that 

there are five fields; Post, Trust, Consultant, Start and Finish.  There are currently only five 

records stored this test data which covers posts 1 to 5, this simple file will be used to show 

how lookups can be used. 

 

Any field, or number of fields, from any record, or number of records, can be overprinted onto 

a questionnaire in the text areas available. 
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Importing Lookups  
 
1.   Open a questionnaire, either by opening a new questionnaire or editing an existing 
questionnaire, 
 2.   From the Configure menu choose lookups. In the Lookups window below it is possible to 
import any number of  lookups which will then be displayed here. 

 
 

 

 3.   Click Import, in the lookup import window, type in a suitable name for the lookup in the Name 

Box.  In the Fields Box below this, type in only the fields that you wish to import for lookups. Click 

Continue. 

 4.   From the Lookup Import File window, select the csv file that contains the lookup data needed 

and click Open. 

 5.   In the import csv window the records chosen to be imported are displayed.  Click OK to 

confirm. 

 6.   In the Confirm window you are notified of the amount of records you are trying to import from 

the lookup file, click YES to continue. 

 7.   The lookups window, shown above will now be updated with the lookups imported.  To add 

more lookups simply repeat steps 3 - 6, to remove an imported lookup click to highlight it and then 

click Remove. 

 8.   Once you are happy that you have the correct lookups imported click OK. 

 9.   Now the lookup file has been imported it is possible to use the records within your 

questionnaire to pre-identify it. 
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Applying a Lookup Filter 

 

The lookup filter function is only available if sheets have been overprinted with lookups. 

 When the sheets are scanned the lookup is read.  

1.   In the Data View window, right click anywhere in the table.  In the pop-up menu left click 

Filter 

2.   In the Filter Data window make sure that the Lookup Filter On box is ticked. 

3.   Click on Tab 4) Lookup.  In this window, the lookup name and the range of values 

available are shown.   

4.   If you right click on a lookup name, a pop up menu will appear with the range of values 

available 

 

 

 

 

 

 

 

 

 

5.   Left click to select the value required in the menu. Repeat as necessary with any other 

lookups available. 

 

6.   Click Save to exit.  You will be asked to confirm filter changes before saving - should any 

changes have been made to the filter. 
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Using Scores 

 

Scores can be added when inserting responses to questions.  The score value will then be 

printed on all reports, next to each response, in brackets.   

 

 

 

 

 

If you use scoring for one response on a sheet you must enter scores for all the responses, it 

is not possible to just add a score for one response. 

 

To add a mean score value added to your report, as above, simply select to Use Means 

where appropriate when formatting the report 
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Merging Scanned Data 
 
One of the advanced features of SpeedQuest is it's ability to merge scanned data.  Lets say 

three campuses each produce a questionnaire with the first 10 questions and responses that 

are the same but the rest of the responses are campus specific.  Each campus will have a 

scanned data file for the questionnaire to produce reports with. By using the functions 

included in SpeedQuest it is also possible for these three separate data files to be merged 

into one - in order to create reports using the common data collected from the first 10 

questions. 

 

This is achieved by exporting the data from each of the three scanned data files and importing 

each of these into a new questionnaire to create a combined data file to report from. 

 

Merging Scanned Data - Step 1 

 

Export the raw file data from the questionnaires that you would like to merge. 

1. Open the .rsq holding the data you want to export. 

2. From the Process Menu click Export Raw Data 

3. In the Select Export File window type in a suitable name for your exported data and save 

it in a suitable directory.  Click Save to confirm. 

 

Continue the above process with all the questionnaire's you would like to merge. 
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Merging Scanned Data - Step 2 

 

Creating a merge file to take all the data. 

 

1. Open a new .rsq by clicking or from the File menu select new then from rsq 

2. In the Select RSQ window select a suitable questionnaire template that can be used for 

the merge files. A suitable template would be one that includes questions & responses that 

are common to the data you intend to import, (removing any  questions & responses that are 

uncommon to all files or not required). 

3. You now need to save this .rsq before you can begin importing data, so click , enter a 

user specified questionnaire number and in the Select RSQ window enter a suitable title for 

your merge file. 

4. Now from the Process Menu click Import - an Import Batch 1 window will now appear 

where you can name the batch you are importing, click Continue if you are happy with the 

batch title (or change it then click Continue) 

5. In the Select Import File window select the file you wish to import.  This will be a .txt 

filetype and will be in the directory you saved your exports to.  When you double click on a file 

a confirm window will appear, this states the number of records found and asks you to confirm 

whether to continue with the import of them.  Click Yes to continue.  A confirmation message 

will appear to confirm your import was successful. 

6. Now by clicking on  you will be able to view the data you have imported. 

 

Continue the above process with all the questionnaires you would like to import.  

 

 
 


